
Take Control of

	 Help 	 Catalog 	 Feedback 	 Order Print Copy 	

VMware
Joe Kissell

	 v1.0

$10 

TidBITS Publishing Inc.

	 Check for Updates
	 Make sure you have the latest information!

Click here to buy the full 130-page “Take Control of VMware Fusion 2” for only $10!

http://www.takecontrolbooks.com/faq.html
http://www.takecontrolbooks.com/catalog.html?14@@!pt=INTERNAL
http://store.eSellerate.net/s.asp?s=STR5625274989&Cmd=BUY&SKURefnum=SKU07652736109&PT=TRK-0070-SAMPLE


2 

Table of Contents 
 

 

READ ME FIRST  4 
Updates................................................................................. 4 
Basics ................................................................................... 5 

INTRODUCTION  8 

FUSION QUICK START  10 

UNDERSTAND FUSION BASICS  11 
What Is Virtualization Software? ..............................................11 
What Is Boot Camp (and Why Should You Care)? .......................15 
Decide Whether (or How) to Use Boot Camp with Fusion .............16 

INSTALL FUSION AND WINDOWS  18 
Collect the Ingredients ...........................................................18 
Install Fusion ........................................................................23 
Create a Virtual Machine in Fusion............................................24 
Install Boot Camp Drivers .......................................................30 
Use a Boot Camp Partition in Fusion .........................................32 

USE WINDOWS IN  A VIRTUAL MACHINE  34 
Learn Your Way Around ..........................................................34 
Suspend, Resume, and Shut Down Windows..............................39 
Make Your Keyboard and Mouse Behave ...................................41 
Switch Display Modes .............................................................45 
Work with Multiple Displays.....................................................51 
Connect and Disconnect Devices ..............................................52 

CONFIGURE VIRTUAL MACHINE SETTINGS  55 
Settings Overview..................................................................55 
Sharing Settings ....................................................................56 
Processor & RAM Settings .......................................................64 
Display Settings ....................................................................67 
Battery Settings ....................................................................68 
Printer Settings .....................................................................69 
AutoProtect Settings ..............................................................70 
Network Settings ...................................................................71 
Hard Disk Settings .................................................................73 
CD & DVD Settings ................................................................76 
Sound Settings......................................................................77 

Click here to buy the full 130-page “Take Control of VMware Fusion 2” for only $10!

http://store.eSellerate.net/s.asp?s=STR5625274989&Cmd=BUY&SKURefnum=SKU07652736109&PT=TRK-0070-SAMPLE


3 

USB Device Settings...............................................................78 
Settings for Other Devices ......................................................80 
Fusion Preferences.................................................................82 

PROTECT YOUR VIRTUAL MACHINE  89 
Keep Windows Safe from Malware............................................89 
Save and Restore Your Windows State with Snapshots................94 
Back Up Your Virtual Machine ..................................................98 

MOVE TO FUSION FROM ANOTHER ENVIRONMENT 104 
Import a Boot Camp Volume .................................................104 
Import a Virtual Machine from Parallels Desktop or Virtual PC ....106 
Import a Windows Installation from a PC ................................107 

APPENDIX A:  
CREATE A SLIPSTREAM INSTALLER DISC  109 

Prepare Your Computer ........................................................109 
Run nLite............................................................................111 
Burn a Slipstream CD or DVD ................................................117 

APPENDIX B: FUSION FOR PROPELLERHEADS  118 
Mount Virtual Disks in the Finder ...........................................118 
Install Mac OS X Server as a Guest Operating System ..............119 
Get Started with VMrun ........................................................122 
Use Virtual Appliances ..........................................................125 

ABOUT THIS BOOK  126 
About the Author .................................................................126 
Author’s Acknowledgments ...................................................126 
Shameless Plug ...................................................................127 
About the Publisher..............................................................127 
Production Credits................................................................127 

 

Click here to buy the full 130-page “Take Control of VMware Fusion 2” for only $10!

http://store.eSellerate.net/s.asp?s=STR5625274989&Cmd=BUY&SKURefnum=SKU07652736109&PT=TRK-0070-SAMPLE


4 

Read Me First 
  
Welcome to Take Control of VMware Fusion 2, version 1.0, pub-
lished in November 2008 by TidBITS Publishing Inc. This book 
was written by Joe Kissell and edited by Tonya Engst. 

VMware Fusion is a powerful and convenient tool for running 
Windows or other operating systems on a Mac. This book teaches 
you all the fundamentals of Fusion, as well as tips and tricks to get 
the most out of running Windows on your Mac. 

Copyright © 2008, Joe Kissell. All rights reserved. 

The price of this ebook is $10. If you want to share it with a friend, 
please do so as you would a physical book: “lend” it for a quick look, 
but ask your friend to buy a new copy in order to read it more care-
fully or to keep it available for reference. Click here to give your 
friend a discount coupon. Discounted classroom and Mac User 
Group copies are also available. 

 

 
 

Sponsored by VMware 
This book was sponsored by VMware. Special 
thanks for an enjoyable collaboration to David 
Liu, Eric Tung, Pat Lee, and Peter Kazanjy.  

  

UPDATES 
Free minor updates to this book may be available. To read any available 
new information, click the Check for Updates link on the cover. On the 
resulting Web page, you can also sign up to be notified of major updates 
via email. If you own only a printed version of the book, or have some 
other version where the Check for Updates link doesn’t work, contact 
TidBITS Publishing at tc-comments@tidbits.com to obtain the PDF. 

Click here to buy the full 130-page “Take Control of VMware Fusion 2” for only $10!
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BASICS 
In reading this book, you may get stuck if you don’t know certain 
fundamental facts about using your Mac or if you don’t understand 
Take Control syntax for things like working with menus or finding 
items in the Finder. Keep reading to learn about these basics, and pay 
special attention to the information about right clicking, since it covers 
the best way to do so not only on the Mac but also in Fusion’s virtual-
ization environment. 

Note: I cover basic terminology and concepts relating to Fusion and 
virtualization in Understand Fusion Basics (p. 11). 

Menus 
Where I describe choosing a command from a menu in the menu 
bar, I use a compact description. For example, to create a new virtual 
machine in Fusion, you choose New from the File menu; I abbreviate 
this by saying “File > New.” 

Finding an Application’s Preferences 
I often refer to preferences in an application that you may want to 
adjust. Don’t confuse an application’s preferences with the system-
wide settings found in System Preferences. 

To access an application’s preferences, choose Application Name > 
Preferences. For example, in VMware Fusion, you would choose 
VMware Fusion > Preferences. Within some applications, all prefer-
ence controls appear in a single window. In others (including Fusion), 
a row of buttons is located across the top. In those cases, click a button 
to display a pane with that category of preferences. Instead of provid-
ing detailed directions each time, I may use an abbreviated notation 
such as “go to the General preference pane.” 

Paths 
I occasionally use a path to show the location of a file or folder in 
your file system. For example, Mac OS X stores most utilities, such 
as Terminal, in the Utilities folder. The path to Terminal is: 
/Applications/Utilities/Terminal. 

The slash at the start of the path tells you to start from the root level of 
the disk. You will also encounter paths that begin with ~ (tilde), which 
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is a shortcut for a user’s home directory. For example, if a person 
with the user name joe wants to install fonts that only he can access, 
he would install them in his ~/Library/Fonts folder, which is another 
way of writing /Users/joe/Library/Fonts. 

Windows uses a different convention for paths, so in cases where 
I’m talking about files in Windows, I start from the hard drive letter 
(usually C:) and use backslashes instead of regular slashes—like so: 
C:\Documents and Settings\Joe Kissell. 

Note: In either Mac OS X or Windows, when typing a path that includes 
spaces, you should enclose the entire path in quotation marks: 
"C:\Documents and Settings\Joe Kissell". Alternatively, in Mac OS X, 
you can precede each space with a backslash and skip the quotation 
marks: /Users/jk/My\ Folder/My\ Document. 

Right-Clicking 
In Mac OS X, when you hold down the Control key and click your 
mouse button, a pop-up contextual menu appears, with commands 
appropriate to whatever is under the pointer. For example, if you 
Control-click on a file in the Finder, you’ll see commands such 
as Get Info, Duplicate, and Make Alias. Although Control-clicking 
nearly always works to open a contextual menu, your mouse or 
trackpad might support a better method: 

• Multi-button mouse: If you have a multi-button mouse (such 
as an Apple Mighty Mouse), you can click the right mouse button 
(“right-clicking”) to display the same menu, assuming you’ve set the 
right button to Secondary Button in the Mouse view of the Keyboard 
& Mouse pane of System Preferences. (You can also set a different 
button to produce a secondary click, if you prefer.) 

• Mac notebook: If you have a Mac notebook computer, you can 
configure the trackpad to display contextual menus when you tap 
with both fingers, or when you put two fingers on the trackpad and 
click the button. To configure this setting, open the Trackpad view 
of the Keyboard & Mouse preference pane. If Clicking is selected 
(meaning you can tap on the trackpad to click), check Tap Trackpad 
Using Two Fingers for Secondary Click. Otherwise, check For 
Secondary Clicks, Place Two Fingers on the Trackpad Then Click 
the Button. 

Click here to buy the full 130-page “Take Control of VMware Fusion 2” for only $10!
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Some newer Mac notebooks (released starting in October 2008) 
have a glass multi-touch trackpad without a separate button. On 
these computers, you configure trackpad behavior in the Trackpad 
pane of System Preferences. To display a contextual menu with 
a single click, check the Secondary Click box under “One Finger,” 
and choose either Bottom Right Corner or Bottom Left corner. 
Press the trackpad in the selected corner with one finger to display 
a contextual menu. Instead or in addition, you can check Secondary 
Click under “Two Fingers,” in which case pressing anywhere on the 
trackpad with two fingers displays a contextual menu. 

Windows, too, has contextual menus accessed with a right click. 
(All mice included with Windows PCs—in fact, virtually all non-Apple 
mice—have at least two buttons.) In Fusion, you can execute a right 
click even if your mouse has only one button—Control-click, just as 
in Mac OS X, and Fusion translates that into a Windows right-click.  

In this book, when I tell you to “right-click” in Windows, that means 
click the right mouse button if you have one (or whichever button 
you’ve designated as “secondary”); Control-click if you have a desktop 
Mac with a one-button mouse; or, on a notebook Mac, use the ges-
ture(s) you’ve configured in the Keyboard & Mouse preference pane 
or the Trackpad preference pane. 

Click here to buy the full 130-page “Take Control of VMware Fusion 2” for only $10!
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Introduction 
  

  
As an enthusiastic Mac user for many years, I’d developed a common 
habit. Every time I heard of some fantastic program that’s available 
only for Windows, I scowled and grumbled, miffed at the fact that 
we Mac users had been marginalized yet again. Mac OS X may be the 
superior operating system, but my Windows-using friends could still 
do cool things with their computers that I couldn’t do with mine—I 
didn’t like that one bit. 

My, how times have changed. Today, I can run virtually any Windows 
program on my Mac as easily as I run native Mac software. For that 
matter, most Linux/Unix programs run beautifully too. In fact, my 
biggest problem is breaking that old habit. I still have an impulse to 
cringe when I see “Windows XP or later” as a system requirement, but 
then I remember: I have an Intel-based Mac. I have the power. 

Maybe it’s a Web site using ActiveX controls that work only in the 
Windows version of Internet Explorer. Maybe it’s a Microsoft business 
application that was never ported to Mac OS X. Or maybe it’s an 
obscure, one-of-a-kind shareware program. Whatever the case, I don’t 
sweat it. It’ll work. Everything works. This magic resulted from Apple’s 
choice to switch to Intel processors, which turned out to be a brilliantly 
shrewd move. 

Apple provides its own way to install Windows on your Mac—Boot 
Camp, included as part of Mac OS X 10.5 Leopard. It works well, but 
it’s awkward in that you must restart your computer to switch operating 
systems. You can’t run a Mac application at the same time as a 
Windows application, and sharing information between the two 
platforms is cumbersome at best. 

This is where virtualization software like VMware Fusion comes in. 
It lets Windows run at near-native speeds right alongside Mac OS X 
on your Intel-based Mac. Not only do you avoid the inconvenience of 
rebooting and gain easy file sharing, you can also even make Windows 
itself effectively disappear so the only traces of Windows you see are 
your Windows applications themselves. In fact, that’s just the start of 

Click here to buy the full 130-page “Take Control of VMware Fusion 2” for only $10!
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the ways in which you can integrate Windows and Mac OS X, for a 
truly seamless environment that can run just about anything. 

VMware Fusion isn’t the only way to do this. Parallels Desktop was the 
first competitor in this category, and a less-powerful but free program, 
VirtualBox (now owned by Sun), also lets you run Windows under Mac 
OS X. (I cover both of these alternatives, as well as Boot Camp, in my 
book Take Control of Running Windows on a Mac.) 

Regardless of the virtues of other approaches to running Windows 
on a Mac, the book you’re now reading focuses entirely on VMware 
Fusion 2. (By the way, the program’s official, trademarked name is 
“VMware Fusion,” but for simplicity I refer to it throughout this book 
simply as “Fusion” or, in some cases, “Fusion 2.”) My goal here is not 
to provide a comprehensive reference guide, but rather to help you 
make the most of Fusion by focusing on the most common, important, 
and interesting tasks you’re likely to perform. By the time you’ve 
finished with this book, you should know how to create that magical 
combination of Windows and Mac OS X that lets you run nearly any 
software on either platform with equal ease. 

As you may know, Fusion supports lots of operating systems—not just 
Windows. Although I mention some of these (particularly Linux and 
Mac OS X Server) from time to time, I assume that Windows is what 
most readers are interested in and direct my attention accordingly. 

I should also mention that Fusion includes some fantastically powerful 
command-line tools for power users. Great as they are, I say little 
about them (except for Appendix B: Fusion for Propellerheads) 
because I assume most people with the geeky disposition to use those 
tools can also figure out how to use them on their own. 

If you need help beyond what’s in this book, you have several options: 

• While running Fusion, choose Help > VMware Fusion Help. 

• Visit the Fusion User Forums at http://communities.vmware.com/ 
community/vmtn/desktop/fusion.  

• Search the VMware Knowledge Base at http://kb.vmware.com/. 

Feel free to write to me at jwk@me.com with comments about this 
book, but please understand that I’m unable to provide personal 
technical support. 

Click here to buy the full 130-page “Take Control of VMware Fusion 2” for only $10!
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Fusion Quick Start 
  
For the most part, this book progresses from basic material through 
more advanced topics. So to get the most out of this book, and of 
Fusion, I recommend working through each section in order. At the 
very least, read Understand Fusion Basics and Use Windows in a 
Virtual Machine before delving into later sections. 

  

Get started: 
• Learn how virtualization works and some of the common terms 

Fusion uses; see Understand Fusion Basics (p. 11). 

• Get Fusion—and Windows (or another operating system of your 
choice) up and running on your Intel-based Mac; see Install Fusion 
and Windows (p. 18). You can also Use a Boot Camp Partition in 
Fusion (p. 32). And for Linux details, see Installing Linux (p. 33). 

• Find out how to use Windows from within Mac OS X; see Use 
Windows in a Virtual Machine (p. 34). 

Customize and maintain your virtual machines: 
• Select the best options for file sharing, RAM usage, and tons of 

other settings; see Configure Virtual Machine Settings (p. 55). 

• Keep Windows safe from malware, user error, and data loss; see 
Protect Your Virtual Machine (p. 89). 

Go beyond the basics: 
• Import a Windows installation from Boot Camp, another vir-

tualization program, or a PC; see Move to Fusion from Another 
Environment (p. 104). 

• Simplify repetitive installations of Windows; see Appendix A: 
Create a Slipstream Installer Disc (p. 109). 

• Use Mac OS X Server in a virtual machine and discover the new 
Fusion command-line tools; see Appendix B: Fusion for Propeller-
heads (p. 118). 

Click here to buy the full 130-page “Take Control of VMware Fusion 2” for only $10!
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Understand Fusion Basics 
  
You’ll have an easier time using Fusion if you start with a bit of 
background about how it works, what terminology it uses, and how 
it can interact with Apple’s Boot Camp software. I describe all these 
things in the next few pages. 

WHAT IS VIRTUALIZATION SOFTWARE? 
Virtualization software, such as Fusion, provides a way for one 
operating system to work within another, while directly accessing 
the same CPU (central processing unit) most of the time. (By contrast, 
emulation software simulates a different type of CPU, resulting in much 
slower performance because of the constant need to translate instruc-
tions.) When such software is running, the environment it creates for 
another operating system (OS) is called a virtual machine, and an 
operating system that runs inside that virtual machine is called a guest 
operating system, in order to distinguish it from the main OS that the 
computer is running, called the host operating system. 

Virtual Machines 
Even though Intel Macs have the same type of CPU as PCs, you still 
need a virtual machine to run Windows within Mac OS X. One reason 
is that apart from the CPU, there are other hardware differences 
between Macs and PCs and thus other hardware components that must 
be emulated (simulated in software). Another reason is that Windows 
expects to have direct access to your hardware, but the host OS (Mac 
OS X in this case) controls the hardware. A virtual machine tricks the 
guest OS into believing it has direct access to the machine’s CPU and 
other hardware, and it emulates any physical devices—such as sound 
cards—that might be different between platforms. 

Each guest operating system that you install requires its own virtual 
machine. If you want, you can install several different operating sys-
tems or several instances of the same operating system; you can even 
run multiple virtual machines at the same time. Fusion gives you the 
choice to run each virtual machine in its own window, in full-screen 
mode, or in Unity view, which means the Windows Desktop disappears 

Click here to buy the full 130-page “Take Control of VMware Fusion 2” for only $10!
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and windows from your Windows applications act more or less like 
windows from Mac applications (see Use Unity View for details.) 

Fusion’s Virtual Machine Library window displays a list of all the 
virtual machines you’ve configured and lets you change a wide variety 
of settings for each one, such as the amount of RAM they use and how 
networking is configured. With only a few exceptions, these settings 
can’t be changed while the guest operating system is running. 

Virtual Disks 
When you set up a new virtual machine, Fusion also creates a special 
disk image file. When you run Windows, it will see this file as a sep-
arate disk. All your Windows files are installed in this virtual disk, 
but when you’re running Mac OS X you won’t see the individual files 
inside; it looks and acts like a single file. You can move this file to 
another disk or another Mac running Fusion, and the virtual machine 
runs just as it did on the original Mac. 

Note: With Boot Camp volumes, which I discuss just ahead, the virtual 
disk is simply a pointer to your Boot Camp partition. 

By default, Fusion gives each new virtual disk for Windows XP or 
Vista a 40 GB capacity (although the disk image file starts out much 
smaller). The disk size can grow to accommodate more files up to the 
maximum size you set, though of course not beyond the amount of 
free space on your real disk. 

Note: Snapshots, which I discuss later (see Save and Restore Your 
Windows State with Snapshots), can increase the amount of real disk 
space used beyond the maximum capacity you set for your virtual 
disks. 

Real and Virtual Hardware 
A big challenge for any virtualization software is enabling commu-
nication between the guest operating system and the computer’s 
hardware—including built-in devices (such as graphics cards and 
network adapters) and external devices (printers, external hard drives, 
and the like). I want to explain a bit about how Fusion handles this 
challenge so you’ll understand what hardware will and won’t work 
under various conditions—and why. 

Click here to buy the full 130-page “Take Control of VMware Fusion 2” for only $10!
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Drivers and Emulated Hardware 
When an operating system is running directly on a computer (such 
as your regular installation of Mac OS X or a Windows installation 
running under Boot Camp), it can access all your hardware directly. 
In general, each device needs a driver—a piece of software that knows 
the device’s capabilities and lets it communicate with your operating 
system. Both Mac OS X and Windows include built-in drivers for 
hundreds of common devices, from keyboards to printers, so you can 
use most hardware without having to install extra software. For third-
party devices that can’t use built-in drivers, manufacturers generally 
offer their own drivers, typically on a CD packaged with the product 
or as a free download. 

But things are different in a virtual machine, because both the host 
operating system and the guest system need access to some of your 
hardware. For example, you must use your mouse in Mac OS X to 
operate Fusion itself (among other things), while the copy of Windows 
running in Fusion also needs to respond to mouse movement and 
clicks. But of course you wouldn’t want to switch to a different mouse 
when you’re running Windows, so Fusion takes your mouse data from 
Mac OS X and passes it through to Windows. 

In some cases, Fusion emulates a particular type of hardware (say, 
a floppy drive or serial port) that isn’t physically there, and Windows 
obligingly uses an appropriate built-in driver to access that virtual 
hardware. In other cases, no existing driver enables proper commu-
nication between Windows and Fusion’s emulated hardware, so 
Windows needs special, Fusion-specific drivers. 

VMware Tools 
Fusion’s collection of drivers is included in a software package called 
VMware Tools. This software not only handles all the basic hardware 
functions (such as sound and video), but also lets Windows do fancy 
things like share files with your Mac OS X host operating system, 
adjust its display resolution automatically when you resize your Fusion 
window, and much more. Because these drivers make using Windows 
(or Linux) a vastly better experience, you should always be sure to 
install them. When you set up a new virtual machine using the Easy 
Install method, Fusion installs VMware Tools for you automatically; 
otherwise, you can install it manually by choosing Virtual Machine > 
Install VMware Tools. 
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Although VMware Tools contains drivers for Fusion’s emulated hard-
ware, it doesn’t include drivers for some custom Apple hardware that 
may be built into your Mac. To use such hardware (including your 
iSight camera and Apple Remote) in Windows, you must install 
Apple’s drivers, which are included with Boot Camp—see Install Boot 
Camp Drivers for instructions. 

Sharing vs. Taking Turns 
Regardless of what drivers you have installed, most of your hardware 
can be used by only one operating system at a time. For example, 
your Mac’s SuperDrive can only be used either by Mac OS X or by 
Windows—but not both at once, because the drive can’t work correctly 
if two different operating systems are giving it competing instructions. 
The same goes for most USB and Bluetooth devices. As a result, you 
must configure your virtual machine to use (or ignore) certain hard-
ware, or use controls in Fusion to manually connect or disconnect 
devices as the need arises. (I say more about this topic in CD & DVD 
Settings, USB Device Settings, and Connect and Disconnect Devices.) 

FireWire Devices 
FireWire devices present an entirely different challenge. For complex 
technical reasons, Fusion can’t take over or even “listen in on” your 
Mac’s FireWire devices, even if you have the proper drivers installed. 
(Neither can Parallels Desktop, by the way.) So as far as Windows 
is concerned, any FireWire devices you’ve may have installed are 
completely invisible. 

This need not be a problem with FireWire hard drives, because you 
can work around the lack of FireWire support by sharing the drives 
(see Sharing Individual Folders for instructions). Likewise, if you have 
a FireWire printer that works in Mac OS X, you can share that printer 
with your virtual machine (as I describe in Printer Settings). 

But other than that, FireWire is unfortunately a non-starter in Fusion. 
FireWire scanners, cameras, audio interfaces, and other gadgets that 
work great in Mac OS X won’t show up at all in Windows. 
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WHAT IS BOOT CAMP  
(AND WHY SHOULD YOU CARE)? 
Fusion and other virtualization programs provide one way to run 
Windows on your Mac. Apple provides a different one—Boot Camp, 
software that’s part of Mac OS X 10.5 Leopard. With Boot Camp, you 
divide your hard disk into two volumes: one for Mac OS X and all your 
Mac applications and data, and the other for Windows. To switch 
between operating systems, you must restart your Mac. 

Apple provides drivers that give Windows access to some Mac-specific 
hardware features such as the built-in iSight camera (on portable Macs 
and iMacs) and the Apple Remote, but other than a few such niceties, 
your Mac running Windows via Boot Camp is, for all practical pur-
poses, just another Intel-based PC. 

The nice thing about Boot Camp is that it gives Windows full, direct 
access to your hardware—100 percent of your CPU power, RAM, 
graphics card, and network bandwidth, for example, go to Windows. In 
fact, some tests have shown that certain Mac models can run Windows 
under Boot Camp faster than PCs with similar specs. In Boot Camp, 
Windows can also use any FireWire devices you may have installed. By 
contrast, when using Fusion, Windows must share resources with Mac 
OS X, potentially making both somewhat slower and less efficient, and 
limiting the kinds of hardware you can use. 

The downside of Boot Camp is that you must always make a choice 
to run one operating system or the other. Let’s say you’re developing 
a Web site using Dreamweaver or BBEdit in Mac OS X and you want 
to test the site, as you go, in Internet Explorer 6 for Windows. To 
do this, you must open the Startup Disk pane of System Preferences, 
select your Windows volume, restart your computer, and run Internet 
Explorer. Then, you have to repeat a similar procedure to restart in 
Mac OS X to make any changes…and repeat this over and over again. 
That’s extremely time-consuming and awkward. Likewise, sharing 
files between the two operating systems may (depending on several 
variables) require jumping through a number of hoops. 

As a result, Boot Camp works best for situations in which your use of 
Windows is entirely separate from your use of Mac OS X. For example, 
if you plan to play a resource-intensive Windows-only game (and do 
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nothing else) for a few hours, rebooting into Windows is no big deal, 
and Boot Camp will give you the best possible performance. But if 
you want to use Mac and Windows programs side-by-side or switch 
between them frequently, Boot Camp isn’t what you want. 

So why, as a Fusion user, should you care about all this? 

Fusion offers two ways to work with Boot Camp. First, you can use 
Fusion to run the copy of Windows you’ve already installed under Boot 
Camp—and switch back and forth at any time between the two ways 
of running that copy of Windows. Second, if you think the benefits 
of Fusion outweigh the benefits of Boot Camp sufficiently that you’ll 
never want to boot directly into Windows again, you can convert your 
Boot Camp installation into a virtual disk and then remove it—thus 
freeing up considerable space on your hard disk. 

I tell you this now because once you install and configure Windows 
(along with your Windows software and documents), you’d most 
likely prefer not to repeat the process. So if you haven’t yet installed 
Windows and think Boot Camp might be useful to you, you should 
install Windows there rather than on a virtual disk. But that choice 
may not be as straightforward as it sounds; read on for help making 
the decision. 

DECIDE WHETHER (OR HOW)  
TO USE BOOT CAMP WITH FUSION 
Fusion gives you three main options with respect to running Windows 
under Boot Camp: 

• Ignore Boot Camp: If you aren’t using Boot Camp now, and if 
you don’t plan to use any Windows applications that need every 
last ounce of CPU power and RAM your Mac has (or direct access 
to FireWire devices), you’ll be happiest ignoring Boot Camp 
altogether. Just install Windows conventionally under Fusion (see 
Create a Virtual Machine in Fusion) and go on your merry way. But 
bear in mind that Fusion offers no way to move a copy of Windows 
from a virtual disk to a Boot Camp volume—if you later decide you 
want to use Boot Camp after all, you’ll have to reinstall Windows 
there from scratch. 
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• Use your Boot Camp volume in Fusion: If you’ve already 
installed Windows in Boot Camp—or if you know you’ll need to—
you can simply configure Fusion to use your Boot Camp installation 
and decide, on any given occasion, whether you want to run 
Windows within Fusion or by rebooting. However, be aware of 
some downsides to this approach: 

◊ Windows is significantly slower to start up and shut down in 
Fusion when running from a Boot Camp partition than when 
running from a disk image. So, using a Boot Camp volume 
in Fusion is more appropriate for occasional use than regular, 
repeated use (in which case installing Windows on a virtual disk 
is the better approach). 

◊ Several nifty Fusion features are unavailable when running 
a Boot Camp installation of Windows in a virtual machine. 
You can’t take snapshots or use AutoProtect; you can’t suspend 
and resume the virtual machine; and you can’t mirror folders 
between Windows and Mac OS X. 

Note: I cover how to use a Boot Camp Windows installation under 
Fusion in Use a Boot Camp Partition in Fusion. 

• Migrate your Boot Camp volume to a virtual disk: If you 
have Windows installed in Boot Camp, you can move that installa-
tion over to a Fusion virtual disk with very little effort—and then, 
once you’re satisfied that it’s running correctly—delete your Boot 
Camp partition, freeing up the disk space it was using. (For 
instructions, see Import a Boot Camp Volume.) 

Having trouble deciding? In my opinion, the convenience of using 
Windows without rebooting overwhelmingly outweighs the minor 
speed boost I get by using Boot Camp. Although installing Windows 
under Boot Camp and running it in a Fusion virtual machine may 
seem like the best of both worlds, my experience has been that 
Windows works far better when running from a virtual disk than 
a Boot Camp partition. After trying it both ways for a while, I finally 
gave up on Boot Camp altogether and imported my erstwhile Boot 
Camp volume into Fusion. So unless you’re absolutely certain that you 
need something you can get only in Boot Camp—and few people do—
my counsel is to stick with a virtual disk. 
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Install Fusion and Windows 
  
Getting Windows up and running under Fusion can be even easier 
than doing so on a PC. Simply follow the steps in this section. How-
ever, if you want to do something special with the way you install 
Windows, you may need to refer to a different area of this book: 

• To Use a Boot Camp Partition in Fusion, skip ahead to the last 
topic in this section (p. 32). 

• To upgrade from an older version of Fusion, read the sidebar 
Upgrade from Fusion 1.x (p. 24). 

• To use an existing Windows installation created under Parallels 
Desktop, Virtual PC, or on an actual PC, see Move to Fusion from 
Another Environment (p. 104). 

• For a few notes on installing Virtual Appliances, consult Use 
Virtual Appliances (p. 125). 

COLLECT THE INGREDIENTS 
Before you can begin setting up Windows under Fusion, you must have 
the necessary hardware and software. 

An Intel-based Mac 
If you have a Mac with an Intel processor (in other words, any model 
introduced in 2006 or later), you can run Fusion. Needless to say, the 
faster your processor(s) and the more cores you have, the better your 
performance will be, but even a slow, single-core Intel-based Mac can 
get the job done. 

The 64-bit question: To run Mac OS X Server or any 64-bit version 
of Windows under Fusion, you must have a Macintosh with a 64-bit 
processor (meaning, at the moment, a Core 2 Duo or Xeon processor). 
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Use Windows in  
a Virtual Machine 
  
Now that Windows is installed, you can run it almost as if you 
were using a PC. In this section, I walk you through the highlights of 
Fusion’s interface—how you run and manage your virtual machines. 
I also discuss how to avoid some of the confusion that can occur 
when running two operating systems at the same time, especially 
when they have different expectations about basic things like mouse 
and keyboard behavior. 

Although I focus on Windows in this section, most of what I 
describe here is equally true of other operating systems you may 
install in Fusion, especially Linux (in that Linux, like Windows—but 
unlike other operating systems—supports Unity view). 

Tip: If, as you’re using Fusion, anything seems not to work quite right, 
check to see if it’s mentioned in the list of Known Issues in Fusion’s 
release notes (http://www.vmware.com/support/fusion2/doc/ 
releasenotes_fusion.html#issues). 

LEARN YOUR WAY AROUND 
Most of the time you spend working in Fusion will involve just two 
windows: the Virtual Machine Library, in which you can select, run, 
and modify virtual machines, and the main Fusion window that con-
tains Windows (or the operating system of your choice) while it’s 
running. 

The Virtual Machine Library 
Fusion’s Virtual Machine Library window (Figure 3) lists all your 
virtual machines. (If it’s not visible, choose Window > Virtual Machine 
Library to display it.) It gives you a central location where you can run 
them and change their settings, as well as create and delete virtual 
machines. 
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Configure Virtual 
Machine Settings 
  
Each virtual machine that you create in Fusion (one per installation 
of Windows or other operating system) can have a wide variety of 
settings, affecting such features as file sharing with Mac OS X, use of 
system resources, and hardware configurations. In addition, Fusion 
has some global preferences that affect how all virtual machines 
behave. I cover these settings in the next several pages. 

SETTINGS OVERVIEW 
To adjust settings for a virtual machine, select the virtual machine in 
the Virtual Machine Library and click the Settings button at the bottom 
of the window. The Settings window (Figure 11) appears. If your vir-
tual machine is running or suspended, this window shows a thumbnail 
on the left. Click a category to change its settings. 

 
Figure 11: The Settings window. Click a category to configure its 
settings for the selected virtual machine. 
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Protect Your Virtual Machine 
  
As a Mac user, you’ve probably never lost any sleep over viruses, 
Trojan horses, worms, spyware, adware, and all the other nasty 
stuff known collectively as malware (that is, malicious software). 
Such programs are few and far between on Mac OS X, but they’re 
a gigantic problem on Windows. Now that you’re running Windows, 
you have to worry about malware too, especially since a program 
could conceivably cause damage not only to your Windows partition 
(or virtual disk) but also to your Mac files. You can learn more about 
malware in Wikipedia: http://en.wikipedia.org/wiki/Malware. 

One way to protect Windows is to check your security settings 
and make sure anti-malware software is installed. Fusion offers 
another layer of protection, too, in the form of snapshots that can 
restore Windows to an earlier state (for example, before virus 
damage occurred). 

In addition, you should have a plan for backing up your Windows 
software and documents. In some situations, your existing Mac 
backup system may do the trick, but you should know about some 
hidden pitfalls and how to work around them—you may want to 
choose a different backup method altogether. 

KEEP WINDOWS SAFE FROM MALWARE 
Preventing attacks by malware (and repairing the damage they’ve 
caused) is a large and complex subject that could easily fill several 
large books. In this section, I want to outline just the basics, acquaint-
ing you with some of the most important steps you should take to 
protect your computer and a few good tools to help you. 

Apply Windows Updates 
In addition to major updates like service packs, Microsoft releases 
numerous smaller updates that fix bugs, plug security holes, and make 
Windows more resistant to malware. You should install these as soon 
as possible after installing Windows (and configure Windows to down-
load and install new updates automatically as they appear). By default, 
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Move to Fusion from 
Another Environment 
  
Installing Windows takes some time, and once you’ve downloaded 
dozens of software updates, added your own programs, and custom-
ized everything to your liking, the prospect of rebuilding all of that 
from scratch is unpleasant at best. So if you’ve already invested that 
effort on a Windows setup in another environment—Boot Camp, 
Parallels Desktop, Virtual PC, or a stand-alone PC—Fusion provides 
an easy way to import your entire existing Windows installation. 

IMPORT A BOOT CAMP VOLUME 
If you already have Windows running in Boot Camp (whether or not 
you’ve used that installation of Windows in Fusion), you can convert 
it to run from a virtual disk instead. As I described in Decide Whether 
(or How) to Use Boot Camp with Fusion, doing this conversion not 
only lets Windows run side-by-side with Mac OS X, it also gives you 
access to more Fusion features (such as snapshots) and enables you 
to free up some of the disk space currently occupied by your Boot 
Camp partition. 

Space: the intermediate frontier: Ironically, although switching 
from Boot Camp to a virtual machine ultimately reduces your disk 
space requirements, you need extra space to start with. To follow 
these steps, you should have at least as much free space on your disk 
as the size of your Boot Camp volume. You’ll get much of that back 
after you deactivate Boot Camp. 

To convert a Boot Camp partition to a virtual machine, follow these 
steps: 

1. In Fusion’s Library window, select your Boot Camp volume and 
click the Import button at the bottom of the window. Enter your 
administrator password when prompted. 
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Appendix A: Create a 
Slipstream Installer Disc 
  
If you plan to install Windows just once and use it indefinitely, 
you can skip this appendix—the normal way of installing Windows, 
described earlier, will work just fine. However, if you expect to 
install Windows repeatedly in a virtual machine (say, for testing 
software under a variety of conditions), you can make your life 
easier by creating a customized Windows installation CD or DVD—
or what’s commonly referred to as a slipstream disc. 

This disc can contain not only Windows itself, but service packs, 
software updates, drivers, preset options (such as your Product Key, 
user name, and password), and other user preferences. Once these 
pieces are integrated into your new slipstream disc, you can install 
a customized version of Windows very quickly, without waiting for 
downloads and updates to complete each time. 

Before we get to the instructions, I should mention that you can 
find dozens of different methods on the Web for creating slipstream 
installers. This is just one of many, but I like it because it’s easy, 
flexible, and fast, and it produced good results for me. 

PREPARE YOUR COMPUTER 
As always, you must assemble certain ingredients and configure 
your computer properly before proceeding. Follow these steps: 

1. Run Windows in a Fusion virtual machine. 

2. If your existing Windows installer disc does not already have the 
latest service pack (as of October 2008, that’s SP3 for Windows XP 
or SP1 for Vista), I strongly recommend obtaining it and integrating 
it into your slipstream installer: 

• You can download Windows XP Service Pack 3 from 
http://www.microsoft.com/downloads/details.aspx?FamilyID=5
b33b5a8-5e76-401f-be08-1e1555d4f3d4&DisplayLang=en. 
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Appendix B: Fusion  
for Propellerheads 
  
Fusion was designed to be easy for ordinary folks to use, without 
requiring any technical expertise. Because this book is geared 
toward a general audience, I’ve steered clear of the geekier features 
that would appeal mainly to system administrators, IT personnel, 
and those of a more technical bent who just like to fiddle. Never-
theless, if you are such a person, Fusion 2 contains a great many 
obscure but delightful capabilities you may want to explore. 

In this appendix, I discuss mounting virtual disks in the Finder 
(when Fusion isn’t running) and installing Mac OS X Server as a 
guest operating system. I also provide a brief overview of Fusion’s 
command-line tool, vmrun, which lets you perform (and even 
script) nearly any Fusion action without touching the graphical 
user interface. Finally, I talk about Virtual Appliances. 

Tip: To learn about many more of Fusion’s extra-geeky features, check 
out a Web page in the Fusion forum called “A Power User’s Guide to 
VMware Fusion,” written by Fusion developer Eric Tung 
(http://communities.vmware.com/docs/DOC-1201). 

MOUNT VIRTUAL DISKS IN THE FINDER 
In some situations, you may want to get at files on your Windows 
volume when Windows is not running. Sure, you could launch Fusion 
and then open your virtual machine, but that may take longer than you 
have—especially if you’re running numerous other programs on your 
Mac that are already maxing out its RAM and CPU. Once you’ve 
installed Fusion 2, you can make use of a shortcut that lets you mount 
your Windows virtual disk even if Fusion isn’t running. 

There are two catches, though. First, the virtual machine whose disk 
you’re opening must be shut down, not suspended. (If the virtual 
machine is suspended, you’d have to launch Fusion and open the 
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About This Book 
  
Thank you for purchasing this Take Control book. We hope you find 
it both useful and enjoyable to read. We welcome your comments at 
tc-comments@tidbits.com. Keep reading in this section to learn 
more about the author, the Take Control series, and the publisher. 
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